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1.  Data models 
The SNB uses two different data models for its surveys – the coordinates-based model and the 
subject-specific model. The data model determines the structure of the delivery formats for 
transmitting the statistical data to the SNB. It is important to note that data for a given survey 
can only be delivered using the specified data model, and there is no choice with respect to 
the delivery format. 

A list of all surveys, together with information on the respective data model and associated 
survey tools, can be found on the SNB website. 

1.1.  Data models and delivery formats 
Depending on the data model used, different formats are available for submitting data. The 
following table provides an overview. 

 
Coordinates-based data model Subject-specific data model 

Web tables excluded Web tables excluded Web tables included 

Survey 
(samples) KRED MONA_U CAS 

Delivery formats 

Coordinates-based Excel format Subject-specific Excel 
format Web tables 

XML/DTD (Document Type Definition) 
for all coordinates-based surveys XML schema per subject-specific survey  

-- -- CSV 

Key 
(samples) 

K021[Z10/K12] BIL.AKT.FMI{CHF,I} 

KRED[Z10, K12] Balance sheet.assets.cash and cash equivalents 
{Swiss franc, domestic} 

Table 1: Overview of delivery formats according to data model 

The main points relating to the data models and delivery formats can also be found on the 
SNB website. 

Different Excel formats are available for the coordinates-based and subject-specific data 
models. For the coordinates-based surveys, there is a DTD (document type definition) that can 
be used to generate all surveys of this type. In the case of the subject-specific surveys, each 
survey has its own separate XML schema. The CSV format is only available for surveys with 
web tables. 

2.  Delivery formats 
The following sections explain the technical aspects of the available delivery formats. The 
notes on the Excel and XML formats are primarily intended for companies wishing to 
automate the delivery of data in XML format. 

https://emi.snb.ch/en/emi
https://www.snb.ch/en/iabout/stat/collect/id/statpub_coll_format
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The explanations in sections 4.1.3. and 4.1.4. focus on the various options available when 
using web tables. Further information on how to use web tables can be found in the Help with 
eSurvey. 

3.  Delivery formats for coordinates-based surveys 
Excel is the main format available for the completion and delivery of surveys that use the 
coordinates-based data model. The information required for the automated delivery of data in 
XML format – such as key, form number and form version – can be extracted from this Excel 
format. 

3.1.1.  Excel format for coordinates-based surveys 
Coordinates-based surveys use the Excel formats XLS 2003 and XLSX 2010 as their basis. 
Surveys of this type comprise at least one form. All forms for a given survey are always 
processed as one report. It is not possible to submit individual forms from a report. 

Each form includes an Excel worksheet with row and column numbers. A survey item is 
defined by its coordinates, which are presented as Form[Row/Column]. 

The worksheets contain control characters to facilitate the reading of data from the forms. 

3.1.1.1.  Form identification 
Every worksheet has a contiguous range of cells, with the reference $fid. This is where the 
form is identified. 

 
Fig. 1: Example of form identification (Excel format for coordinates-based surveys) 

https://surveys.snb.ch/public/hilfe/E_hilfe.html
https://surveys.snb.ch/public/hilfe/E_hilfe.html
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3.1.1.2.  Version and revision numbers 
The ‘version’ number (e.g. 1.00) defines the valid positions (row/column combinations) for a 
given time interval for a form. In a survey that includes multiple forms, the versions of the 
individual forms may differ. The ‘revision’ number (e.g. D02) contains information on the 
language1 of the Excel form and any corrections made (e.g. consistency rule adjustments). If 
an Excel form is submitted for a specific reference date with an incorrect version or revision 
number, the system will be unable to process the report and it will therefore be rejected. The 
revision number is not relevant for the XML format and is not specified there. 

3.1.1.3.  Data range 
The end of the form is defined with the cell reference $eod (end of data). The range between 
the beginning of the data (Col.01) and the end of the data ($eod) defines the data range to be 
read. 

 
Fig. 2: Selection of data range with $eod (Excel format for coordinates-based surveys) 

 

A position within a form’s data range is determined by combining row and column numbers. 

 
Fig. 3: Position coordinates, with row and column numbers (Excel format for coordinates-based surveys) 

 

1 D for German, F for French, E for English. 
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When processing such an Excel file, only worksheets with ‘.MELD’ in the tab name are read. 

 
Fig. 4: Example of syntax of worksheet being read (Excel format for coordinates-based surveys) 

 

If control characters are missing or moved, the report cannot be read and a new submission 
will be requested. 

3.1.1.4.  Sheet protection 
All Excel survey documents are provided with the sheets protected (without password). 

3.1.2.  XML format for coordinates-based surveys 
A coordinates-based XML file may contain multiple coordinates-based surveys concurrently. 
If a corrected delivery is required, the resubmission must contain at least the entire survey that 
was previously rejected. We therefore recommend creating only one XML file per survey 
(with the exception of the FOND survey). 

3.1.2.1.  Document Type Definition (DTD) 
For coordinates-based surveys, the DTD used for generating XML reports defines the 
specifications, which are the same for all coordinates-based surveys. 

The XML file consists of one <deliveryNote> and an unlimited number of 
<deliveredReports>. <deliveredReports> can contain <simpleReports> (e.g. for KRED), 
<parametrizedReports> (e.g. for LCR) or <anfoReports> for FOND. 

All details relating to DTD can be found on the SNB website. 

<?xml version='1.0' encoding='ISO-8859-1' ?> 
<!DOCTYPE SNBReports SYSTEM  "snbreports-v001.dtd"> 
<SNBReports version='0.01'> 
    <deliveryNote> 
        <subjectId>123456</subjectId> 
        <dateCreated>23.07.2016</dateCreated> 
        <timeCreated>14:22:39</timeCreated> 
        <deliveryType>eSurvey</deliveryType> 
        <contentType>production data</contentType> 
        <subjectAddress> 
            <subjectName>FIRMA GMBH</subjectName> 
            <street>Sonnenstrasse 41</street> 
            <zip>8002</zip> 
            <city>Zürich</city> 

https://www.snb.ch/n/mmr/reference/statpub_coll_xmlspec/source


 7 February 2024 
Help with delivery formats 

 
 
 

 Page 7/29  
 

        </subjectAddress> 
        <contacts> 
            <contact> 
                <contactName>Hans Müller</contactName> 
                <contactType>statistic</contactType> 
                <contactPhone>051 113 1313</contactPhone> 
                <contactEmail>hans.mueller@firma.ch</contactEmail> 
            </contact> 
        </contacts> 
    </deliveryNote> 
    <deliveredReports> 
        <referDate>30.06.2020</referDate> 
        <simpleReports> 
            <numberOfReports>1</numberOfReports> 
            <nReport> 
                <reportName>CAB01</reportName> 
                <reportVersion>1.00</reportVersion> 
                <observations> 
                    <numberOfObservations>15</numberOfObservations> 
                    <obs><x>3</x><y>101</y><o>34.30514</o></obs> 
                    <obs><x>3</x><y>201</y><o>3.37961</o></obs> 
                    <obs><x>3</x><y>102</y><o>94.83413</o></obs> 
                    <obs><x>3</x><y>103</y><o>94.83413</o></obs> 
                    <obs><x>3</x><y>202</y><o>31.32913</o></obs> 
                    <obs><x>3</x><y>203</y><o>0.6568</o></obs> 
                    <obs><x>3</x><y>204</y><o>30.67233</o></obs> 
                    <obs><x>3</x><y>110</y><o>0.12503</o></obs> 
                    <obs><x>4</x><y>101</y><o>4.1997</o></obs> 
                    <obs><x>4</x><y>201</y><o>0.14416</o></obs> 
                    <obs><x>4</x><y>202</y><o>0.00215</o></obs> 
                    <obs><x>4</x><y>203</y><o>0.00215</o></obs> 
                    <obs><x>4</x><y>110</y><o>0.00491</o></obs> 
                    <obs><x>31</x><y>101</y><o>10.86208</o></obs> 
                    <obs><x>31</x><y>201</y><o>3.50152</o></obs> 
                 </observations> 
            </nReport> 
        </simpleReports>    
    </deliveredReports> 
</SNBReports> 

Fig. 5: Example of valid XML file for a coordinates-based survey 

 

3.1.2.2.  Form identification, version numbers and data ranges 
Information relating to the report or form designations, the form versions and the row and 
column coordinates can be found in the corresponding Excel forms. 



 7 February 2024 
Help with delivery formats 

 
 
 

 Page 8/29  
 

 
Fig. 6: Form information in XML file (XML format for coordinates-based surveys) 

 

The screenshot above shows the designation of the reportName and reportVersion in a given 
coordinates-based Excel survey document, and the screenshot below the designation of the 
<obs> <x> and <y> coordinates. 
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Fig. 7: Coordinates and data in XML file (XML format for coordinates-based surveys) 

 

4.  Delivery formats for subject-specific surveys 
The delivery formats that are available for subject-specific surveys depend on whether the 
survey in question uses web tables or Excel forms to record data. Surveys that do not use web 
tables for data collection can be submitted in either Excel or XML format. For those that do 
use web tables, data can be entered directly in the web table itself or be submitted in CSV or 
XML format. 

4.1.1.  Excel format for subject-specific surveys 
Subject-specific Excel survey forms are based on the XLSX file format, which has been the 
standard since Microsoft Office 2007. These Excel survey forms use the XML schema 
functionality2 in Excel, which was introduced together with the XLSX format. The XML 
schema supplied with Excel is identical to the schema for the XML reports. 

The Excel coordinates (row numbers and column names) in the tables are provided solely to 
simplify communications. The link between Excel coordinates and data points is dynamic, i.e. 
not static, and may therefore change over time. In conjunction with the Excel survey 

 

2 https://support.microsoft.com/en-gb/office/overview-of-xml-in-excel-f11faa7e-63ae-4166-b3ac-
c9e9752a7d80?ocmsassetid=ha010206396&correlationid=1911d025-64a6-474a-865f-3ba37baac3b1&ui=de-de&rs=de-de&ad=de  

https://support.microsoft.com/en-gb/office/overview-of-xml-in-excel-f11faa7e-63ae-4166-b3ac-c9e9752a7d80?ocmsassetid=ha010206396&correlationid=1911d025-64a6-474a-865f-3ba37baac3b1&ui=de-de&rs=de-de&ad=de
https://support.microsoft.com/en-gb/office/overview-of-xml-in-excel-f11faa7e-63ae-4166-b3ac-c9e9752a7d80?ocmsassetid=ha010206396&correlationid=1911d025-64a6-474a-865f-3ba37baac3b1&ui=de-de&rs=de-de&ad=de
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documents, reports in the XML delivery format may be imported into the corresponding 
Excel survey documents. 

Report data is extracted from the Excel report using an XML data export.3 The mapping of 
Excel cells onto XML schema elements is defined by an XML schema map tailored to each 
specific survey.4 

The reporting institution must indicate the identification code (SNB code) and the reference 
date provided in the ‘Start’ worksheet. 

4.1.1.1.  Restrictions 
The key element of subject-specific Excel survey documents is the associated XML schema 
and the linkage of Excel cells with the XML elements in this schema. Manipulating Excel 
survey documents (e.g. renaming worksheets, inserting or deleting cells, changing the XML 
schema) can render these linkages with the XML schema unusable or may result in data 
values being allocated to the wrong positions. Altering the XML schema is therefore not 
permitted. 

Cells that contain formulas or references to external data sources may lead to problems during 
processing. The SNB therefore recommends avoiding such constructs when completing 
reports. The reporting process can be automated using the XML delivery format (cf. 4.1.1.7. 
Automation). 

If, during the processing of a report, any unauthorised modifications are identified or any 
errors due to formulas or references are encountered, the system will be unable to process the 
report and it will therefore be rejected. 

4.1.1.2.  Version, revision and technical numbers 
In the subject-specific Excel survey documents, the version and revision numbers can be 
found in the ‘Start’ worksheet as well as in the metadata of the XML schema. There is only 
one version number for the entire survey (whereas for coordinates-based surveys, there is one 
version for every form). The version defines the valid key domain. If the version number 
changes, so too does the key domain. If the version number changes, the new version and 
associated key domain must always be used. Submissions that do not correspond to the 
expected version cannot be processed. 

The revision number relates only to the Excel format and is changed, for instance, when the 
consistency rules are amended. If a change is required, or if a survey document with an older 
revision number can still be used, this will be indicated in the Release Notes of the respective 
release. 

 

3 https://support.microsoft.com/en-gb/office/export-xml-data-0b21f51b-56d6-48f0-83d9-
a89637cd4360?ocmsassetid=hp010206401&correlationid=54477787-c118-42ba-9361-03c6d268abd7&ui=de-de&rs=de-de&ad=de  

4 For details of how to display XML schema maps, cf. 4.1.1.8. Displaying XML schema maps. 

https://support.microsoft.com/en-gb/office/export-xml-data-0b21f51b-56d6-48f0-83d9-a89637cd4360?ocmsassetid=hp010206401&correlationid=54477787-c118-42ba-9361-03c6d268abd7&ui=de-de&rs=de-de&ad=dehttp%3A%2F%2Foffice.microsoft.com%2Fde-ch%2Fexcel-help%2Fexportieren-von-xml-daten-HP010206401.aspx
https://support.microsoft.com/en-gb/office/export-xml-data-0b21f51b-56d6-48f0-83d9-a89637cd4360?ocmsassetid=hp010206401&correlationid=54477787-c118-42ba-9361-03c6d268abd7&ui=de-de&rs=de-de&ad=dehttp%3A%2F%2Foffice.microsoft.com%2Fde-ch%2Fexcel-help%2Fexportieren-von-xml-daten-HP010206401.aspx
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The technical number is for internal purposes and can be ignored. It is incremented as soon as 
a survey document is imported into the system. 

 

 
Fig. 8: Version, revision and technical numbers (Excel format for subject-specific surveys) 

 

4.1.1.3.  Sheet protection 
All Excel survey documents are provided with the sheets protected (without password). 

4.1.1.4.  Carrying out consistency checks 
Cf. Using consistency rules in subject-specific survey documents 

4.1.1.5.  Exporting XML data 
A valid XML report can be generated using a subject-specific Excel survey document. 

The recorded data are exported as an XML file using the XML schema supplied in the Excel 
survey document. An XML file exported in this way is considered by the SNB to be a valid 
XML report, which can be submitted via eSurvey. 

The contents of the Excel file can be saved in the XML Data format via the menu item ‘File’ 
→ ‘Save As’.5 

 

 

5 Alternatively, XML data can also be exported via the ‘Developer’ tab (cf. Fig. 15: Automation: Activating ‘Developer’ tab (Excel format 
for subject-specific surveys)). 

http://www.snb.ch/en/mmr/reference/statpub_coll_format_konsiregeln/source
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Fig. 9: Saving Excel file as XML data (Excel format for subject-specific surveys) 

 

The following dialog box can be ignored and closed by clicking ‘Continue’. 

 
Fig. 10: Saving Excel file as XML data: Dialog box (Excel format for subject-specific surveys) 

 

The export to an XML file is initiated by selecting the XML map ‘Report’. 

 
Fig. 11: Saving Excel file as XML data: Mapping (Excel format for subject-specific surveys) 

 

The identification code (SNB code) and reference date must be entered in the ‘Start’ 
worksheet in order for a data export to an XML file to function properly. If either of these 
values are missing, an error message will be displayed during the export process. 
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Fig. 12: Saving Excel file as XML data: Error message (Excel format for subject-specific surveys) 

 

4.1.1.6.  Importing XML data 
The data saved in an XML report can be imported into the respective Excel survey document 
for control purposes. This enables the user to review the observations in the XML report in 
tabular form. If the import returns no errors, it means the structure of the XML file has also 
been validated. 

To ensure an error-free import, it is essential that the versions of both delivery formats are 
identical (cf. 4.1.1.2. Version, revision and technical numbers). 

An XML report is imported into the respective Excel survey document as follows:6 In the 
‘Developer’ tab, click on ‘Import’ and select the appropriate XML file.7 

 
Fig. 13: Importing data from XML file to Excel file (Excel format for subject-specific surveys) 

 

6 Sheet protection must first be removed, as otherwise the ‘Import’ menu item may be deactivated. 
7 To do this, the ‘Developer’ tab must be activated (cf. Fig. 15: Automation: Activating ‘Developer’ tab (Excel format for subject-specific 

surveys)). 
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The import process commences with the selection of an XML file. If no errors occur during 
the import, the data from the XML file will be displayed in Excel. 

If one or more errors are encountered, a dialog box detailing the errors will appear. Additional 
information on the reason for the error can be obtained by clicking on ‘Details...’. 

 
Fig. 14: Importing data from XML file to Excel file: Error message (Excel format for subject-specific surveys) 

 

Possible reasons for import errors: 

− Error during schema verification: The XML file does not correspond to the 
specifications defined in the XML schema (e.g. languages differ or date format 
deviates from yyyy-mm-dd format). 

− XML parsing error: Syntax errors in XML file. 

4.1.1.7.  Automation 
The Excel delivery format is suitable for entering data manually or checking data, but is not 
suited to automating the reporting process. 

To achieve process automation, the SNB recommends using the XML delivery format, as this 
is the recognised format for transferring data between systems. 

The SNB reserves the right to reject Excel and XML reports that have been corrupted due to 
automation. 

Activate ‘Developer’ tab (Excel 2010): To activate this tab, go to File → Options → 
Customize Ribbon and under ‘Main Tabs’ click on ‘Developer’. 
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Fig. 15: Automation: Activating ‘Developer’ tab (Excel format for subject-specific surveys) 

 

4.1.1.8.  Displaying XML schema maps 
For a better understanding of how subject-specific content is rendered in Excel survey 
documents, the mapping of Excel cells to XML schema elements can be shown in Excel. 

In the ‘Developer’ tab, click on ‘Source’ to display the XML maps.8 

Displaying the XML maps facilitates navigation. If a key is selected in the XML map, the 
corresponding position in the worksheet or cell will be framed in yellow. Conversely, if a 
position is selected in the worksheet, the key will be highlighted in blue in the XML map. 

 

8 To do this, the ‘Developer’ tab must be activated (cf. Fig. 15: Automation: Activating ‘Developer’ tab (Excel format for subject-specific 
surveys)). 
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Fig. 16: XML maps (Excel format for subject-specific surveys) 

 

4.1.2.  XML format for subject-specific surveys 
The same XML format is used with both the subject-specific Excel survey documents and the 
web tables. In other words, the XML schema for web tables is the same as for those surveys 
that also use subject-specific survey documents. Excel cannot be used in combination with 
web tables and XML schema, however, as there is no Excel option for web tables. 

The SNB provides the relevant XML schemata for all subject-specific surveys. The structure 
of the XML schemata – which is the same for all surveys – falls into two categories: 
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Metadata: These data identify the reporting institution’s report. Metadata are static for all 
XML schemata and identical for every survey. An exception is <ReportDomainName>, 
which is only available in conjunction with web tables. 

 
Fig. 17: Meta data in XML file (XML format for subject-specific surveys) 

 

The reporting institution must indicate the identification code ‘SubjectID’ and the reference 
date ‘ReferDate’ in the yyyy-mm-dd format (e.g. 2014-12-31). All other details are control 
information for processing reports and may not be altered, as per the requirements set out in 
the XML schema. ‘Revision’, ‘TechNumber’ and ‘Language’ are optional for XML reports 
and should not be provided. 

Observation data: This is where observations are queried on the basis of the subject-specific 
content of a survey. Subject-specific content may change over time. Changes may relate to the 
subject-specific keys, and positions may be added and/or removed. In the event of any 
changes, the SNB will provide a new version of the XML schema. 

Reporting institutions must ensure that reports submitted in the XML delivery format 
correspond to the relevant XML schema.9 Reports that do not adhere to the schema cannot be 
processed by the system and will therefore be rejected. 

4.1.2.1.  Restrictions 
An XML file may only contain a report for one survey. Consolidating different reports and/or 
surveys into one XML file is not possible for subject-specific surveys. 

4.1.2.2.  XML format for web tables 
The XML format for web tables is also based on the subject-specific model. A distinctive 
feature here is that there may be a set of preliminary questions in the web tables (such as in 
the CAS survey), which helps to customise the survey content. These questions are also 
mapped in the XML schema and form part of the report. Each answer to a question 
corresponds to a component and represents a given key domain. Mandatory questions must 
also be answered in XML. The remaining questions relate to the customisation of the survey 
content and the value ‘EMPTY’ must be given for all these questions. 

 

9 The SNB recommends using a standard XML editor to generate an XML file. With these editors, position names can be displayed as per 
the XML schema. 
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4.1.3.  Web tables for subject-specific surveys 
Web tables are based on the subject-specific data model and are integrated into eSurvey. If a 
survey is provided in the form of web tables, the Excel option is no longer available. The 
CSV format can be used in addition to web tables (cf. 4.1.4. CSV format for subject-specific 
surveys). The XML schema – which can also be used with web tables – corresponds to the 
one used for the subject-specific data model (cf. 4.1.2. XML format for subject-specific 
surveys). 

By answering the preliminary questions, reporting institutions can tailor the web tables to 
include the survey content specifically relevant to them. The purpose of this is to make the 
reportable data more readily comprehensible. Furthermore, the notes on the individual surveys 
can be displayed directly in the web tables to aid data entry. Both are intended to contribute to 
a better understanding of the data requirements and to assist reporting institutions in preparing 
reports. 

Data can be entered directly in the web tables, either manually or by inserting data from 
external sources. However, protected cells must be omitted from the copying process. 

The reporting process can be automated using the XML format. Likewise, the entire or 
previously customised survey content can be downloaded as a CSV file. 

Additionally, in conjunction with the user administration in eSurvey, the system allows 
reports to be stored temporarily and processed by different users. At the same time, the web 
tables also permit access to previously submitted reports. 

 

 
Fig. 18: Sample view of web table 
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4.1.4.  CSV format for subject-specific surveys 
The CSV delivery format is an additional format that can be used with web tables. The CSV 
file can be opened in Excel and linked with internal Excel or other data sources. This allows 
reports to be prepared either locally or offline. Reports created in this way can then be 
uploaded into the web tables where they can be displayed, edited where necessary, checked 
for consistency and finally submitted. 

4.1.4.1.  Technical specifications of the CSV format 
The following format must be adhered to when processing the CSV: 

• Character set encoding:  

• Windows-1252 or ISO-8859-1 (Western Europe) for Windows or Linux 

• UTF8 for MacOS or Linux  

• The column separator is a semicolon (;) 

• If the column separator (;) is contained in a value (‘Value’ column), the value must be 
placed in inverted commas ("). 

• For the import into eTable, at least the ‘Position’ column (position key) and the 
‘Value’ column (observation/question value) must be present. 

4.1.4.2.  Editing CSV file 
The figures in a CSV report must be in Swiss format ([decimal separator: point], [optional: 
thousands separator: inverted comma, e.g.: 10'000'000.00]). If you normally use another 
format, when you open the CSV format in Excel under ‘Advanced options’, you must ensure 
that the decimal separator is set as a point and the thousands separator as an inverted comma. 
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Fig. 19: Setting Swiss number format for editing CSV template 

 

To make editing easier, you can adapt the column widths in the CSV file opened in Excel so 
that you can see the whole sheet. You can get a better overview by setting up a filter. 

If a CSV file is created from Excel via ‘Save As...’, double quotation marks are placed only 
where needed. This is also permitted. 
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Fig. 20: Saving Excel as CSV 

 

4.1.4.3.  Changing regional settings in Windows 
In order to be able to process the CSV formats directly with Excel, the required formats must 
be set to German (Switzerland) in the regional settings. Individual settings, e.g. column 
separators, can be changed there as follows: 

1. Click on the ‘Start’ menu, then open ‘Settings’. Select ‘Time & Language’, ‘Region’, 
then open ‘Additional date, time & regional settings’: 

 

 
 

Fig. 21: Opening regional settings 

2. Open region 
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Fig. 22: Opening region 

3. Additional settings 

 

 
 

Fig. 23: Additional settings 

Change the relevant setting, e.g. the list separator and the decimal symbol: 
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Fig. 24: Setting list separator and decimal symbol 

4.1.4.4.  Opening CSV file without changing regional settings 
The CSV file can be imported into Excel (Windows and MacOS) or opened in OpenOffice 
(Linux) if the regional settings cannot be changed. 

1. In Excel, the CSV file is imported via ‘Data’ -> ‘Get External Data’ -> ‘From Text’. 
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Fig. 25: Importing CSV into Excel 

 

2. Under ‘Original data type’, choose the file type ‘Delimited’ and then select the 
following character set under ‘File origin’):  

For Windows and MacOS: Windows (ANSI) 
For Linux: Western Europe (ISO-8859-1) 

 

  

 
 

Fig. 26: Setting original data type 

 

3. Under ‘Delimiters’, select ‘Semicolon’ and under ‘Text qualifier’ (string delimiter), 
select double inverted comma ("). 
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Fig. 27: Defining the delimiter and text qualifier 

4. The column formats can be left unchanged. 

5. Click ‘Finish’ to conclude the import (with the cell position =$A$1 in the subsequent 
dialogue). 

6. To save the report for uploading, specify the file name in the save dialogue and use the 
following format: 

For Windows: CSV (Comma delimited)(*.csv)  
For MacOS: CSV-UTF-8 
For Linux: CSV-Text 

4.1.4.5.  Sections of CSV file 
The CSV file contains the following sections: 

#Meta-data: This section identifies the report and contains the link to the notes. 

#Questions (mandatory and non-mandatory): The questions in the CAS survey relate to the 
web tables ‘Questions on your company’ and ‘Select components’ and are divided into two 
sections. The mandatory questions (‘Questions on your company’) are displayed at the top of 
the CSV file before the other observations. The other questions (‘Select components’) come 
after the observations section (#Questions). We recommend completing these questions in the 
web table, then exporting the CSV file. 

#Observations: This section contains the list of keys, including their description for those web 
tables for which a report is required. If no applicable components were previously selected in 
the web tables under ‘Select components’, this list will contain the entire key domain of the 
survey. We therefore recommend you preselect the relevant survey content in the web tables 
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by explicitly selecting the applicable components. We do not recommend deleting keys in the 
CSV file later on (cf. Help with eSurvey). 

#Content domain definition: This section contains the information about the content 
configuration of the survey, which represents the link between the questions, the sections and 
the associated positions. This section is not to be edited. 

4.1.4.6.  Columns in CSV file 
The CSV file contains the following columns: 

The ‘Position’ column contains the technical descriptors or subject-specific keys of the survey 
for each section. See also the previous section for information in this regard. 

The values for the positions to be reported must be entered in the ‘Value’ column. 

 

 

https://surveys.snb.ch/public/hilfe/E_hilfe.html
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Fig. 28: Structure of CSV delivery format 

 

The ‘Type’ column defines the required data type for the value that is to be reported in the 
‘Value’ column. The following formats apply: 

• DATE: DD.MM.YYYY 

• DOUBLE: Example: 100000.00 (decimal point required as decimal separator) 

• ENUM: Defined range of values (possible values are listed in the ‘Type’ column). 
Example: ENUM (mandatory) [IFR,USG,SWG,OTH] (mandatory) 

• STRING (mandatory): Text (mandatory) 

• BOOLEAN: True, false 

The ‘Value’ column may also contain references. This can be problematic, however, if such 
references cannot be resolved or updated. 

The best way to deal with references is to keep them in the ‘EXT Link’ column and then to 
transfer them to the ‘Value’ column using ‘Copy’ and ‘Paste Values’. 

The ‘Range’ column shows which web table corresponds to a given position. This column can 
be used for filtering. 

The information in the ‘Predicate’ column is used to identify the content configuration of the 
survey. This column does not require any editing by the reporting institution. 

The ‘Component’ column and the ‘Dimension’ columns contain the component designation 
and the dimensions for a position’s key. These columns can be used for filtering. 
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4.1.4.7.  Special features Current account survey (CAS): Questions on your company 
In the CAS survey, there is a special feature in the web table ‘Questions on your company’ 
with regard to recording group-affiliated companies. For every company listed, the following 
values are recorded in one line: ‘Enterprise identification number (UID)’, ‘Company name’, 
‘Town’ and ‘Included in the report’. These lines are displayed only twice in the CSV 
template. When entering several companies, these lines must be copied in the CSV file, and in 
the keys the dataset’s counter must be increased by one (e.g. from #GES[1] to #GES[2]). 

 

 
Fig. 29: Group-affiliated companies in web table 

 

 

 

 



 7 February 2024 
Help with delivery formats 

 
 
 

 Page 29/29  
 

Fig. 30: Group-affiliated companies in CSV template 

 

If the preliminary question ‘Are several relevant companies in the same group domiciled in 
Switzerland or Liechtenstein?’ is answered with ‘YES’ (in the web table with ‘Yes’), at least 
one company must be recorded in the first line (‘mandatory’). This does not apply, however, 
if the question is answered with ‘NO’. 


	Zurich, 7 February 2024
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	1.  Data models
	The SNB uses two different data models for its surveys – the coordinates-based model and the subject-specific model. The data model determines the structure of the delivery formats for transmitting the statistical data to the SNB. It is important to note that data for a given survey can only be delivered using the specified data model, and there is no choice with respect to the delivery format.
	A list of all surveys, together with information on the respective data model and associated survey tools, can be found on the SNB website.
	1.1.  Data models and delivery formats

	Depending on the data model used, different formats are available for submitting data. The following table provides an overview.
	Coordinates-based data model
	Subject-specific data model
	Web tables excluded
	Web tables excluded
	Web tables included
	Survey(samples)
	KRED
	MONA_U
	CAS
	Delivery formats
	Coordinates-based Excel format
	Subject-specific Excel format
	Web tables
	XML/DTD (Document Type Definition) for all coordinates-based surveys
	XML schema per subject-specific survey
	--
	--
	CSV
	Key(samples)
	K021[Z10/K12]
	BIL.AKT.FMI{CHF,I}
	KRED[Z10, K12]
	Balance sheet.assets.cash and cash equivalents {Swiss franc, domestic}
	Table 1: Overview of delivery formats according to data model
	The main points relating to the data models and delivery formats can also be found on the SNB website.
	Different Excel formats are available for the coordinates-based and subject-specific data models. For the coordinates-based surveys, there is a DTD (document type definition) that can be used to generate all surveys of this type. In the case of the subject-specific surveys, each survey has its own separate XML schema. The CSV format is only available for surveys with web tables.
	2.  Delivery formats
	The following sections explain the technical aspects of the available delivery formats. The notes on the Excel and XML formats are primarily intended for companies wishing to automate the delivery of data in XML format.
	The explanations in sections 4.1.3. and 4.1.4. focus on the various options available when using web tables. Further information on how to use web tables can be found in the Help with eSurvey.
	3.  Delivery formats for coordinates-based surveys
	Excel is the main format available for the completion and delivery of surveys that use the coordinates-based data model. The information required for the automated delivery of data in XML format – such as key, form number and form version – can be extracted from this Excel format.
	3.1.1.  Excel format for coordinates-based surveys

	Coordinates-based surveys use the Excel formats XLS 2003 and XLSX 2010 as their basis. Surveys of this type comprise at least one form. All forms for a given survey are always processed as one report. It is not possible to submit individual forms from a report.
	Each form includes an Excel worksheet with row and column numbers. A survey item is defined by its coordinates, which are presented as Form[Row/Column].
	The worksheets contain control characters to facilitate the reading of data from the forms.
	3.1.1.1.  Form identification

	Every worksheet has a contiguous range of cells, with the reference $fid. This is where the form is identified.
	/
	Fig. 1: Example of form identification (Excel format for coordinates-based surveys)
	3.1.1.2.  Version and revision numbers

	The ‘version’ number (e.g. 1.00) defines the valid positions (row/column combinations) for a given time interval for a form. In a survey that includes multiple forms, the versions of the individual forms may differ. The ‘revision’ number (e.g. D02) contains information on the language of the Excel form and any corrections made (e.g. consistency rule adjustments). If an Excel form is submitted for a specific reference date with an incorrect version or revision number, the system will be unable to process the report and it will therefore be rejected. The revision number is not relevant for the XML format and is not specified there.
	3.1.1.3.  Data range

	The end of the form is defined with the cell reference $eod (end of data). The range between the beginning of the data (Col.01) and the end of the data ($eod) defines the data range to be read.
	/
	Fig. 2: Selection of data range with $eod (Excel format for coordinates-based surveys)
	A position within a form’s data range is determined by combining row and column numbers.
	/
	Fig. 3: Position coordinates, with row and column numbers (Excel format for coordinates-based surveys)
	When processing such an Excel file, only worksheets with ‘.MELD’ in the tab name are read.
	/
	Fig. 4: Example of syntax of worksheet being read (Excel format for coordinates-based surveys)
	If control characters are missing or moved, the report cannot be read and a new submission will be requested.
	3.1.1.4.  Sheet protection

	All Excel survey documents are provided with the sheets protected (without password).
	3.1.2.  XML format for coordinates-based surveys

	A coordinates-based XML file may contain multiple coordinates-based surveys concurrently. If a corrected delivery is required, the resubmission must contain at least the entire survey that was previously rejected. We therefore recommend creating only one XML file per survey (with the exception of the FOND survey).
	3.1.2.1.  Document Type Definition (DTD)

	For coordinates-based surveys, the DTD used for generating XML reports defines the specifications, which are the same for all coordinates-based surveys.
	The XML file consists of one <deliveryNote> and an unlimited number of <deliveredReports>. <deliveredReports> can contain <simpleReports> (e.g. for KRED), <parametrizedReports> (e.g. for LCR) or <anfoReports> for FOND.
	All details relating to DTD can be found on the SNB website.
	<?xml version='1.0' encoding='ISO-8859-1' ?><!DOCTYPE SNBReports SYSTEM  "snbreports-v001.dtd"><SNBReports version='0.01'>    <deliveryNote>        <subjectId>123456</subjectId>        <dateCreated>23.07.2016</dateCreated>        <timeCreated>14:22:39</timeCreated>        <deliveryType>eSurvey</deliveryType>        <contentType>production data</contentType>        <subjectAddress>            <subjectName>FIRMA GMBH</subjectName>            <street>Sonnenstrasse 41</street>            <zip>8002</zip>            <city>Zürich</city>        </subjectAddress>        <contacts>            <contact>                <contactName>Hans Müller</contactName>                <contactType>statistic</contactType>                <contactPhone>051 113 1313</contactPhone>                <contactEmail>hans.mueller@firma.ch</contactEmail>            </contact>        </contacts>    </deliveryNote>    <deliveredReports>        <referDate>30.06.2020</referDate>        <simpleReports>            <numberOfReports>1</numberOfReports>            <nReport>                <reportName>CAB01</reportName>                <reportVersion>1.00</reportVersion>                <observations>                    <numberOfObservations>15</numberOfObservations>                    <obs><x>3</x><y>101</y><o>34.30514</o></obs>                    <obs><x>3</x><y>201</y><o>3.37961</o></obs>                    <obs><x>3</x><y>102</y><o>94.83413</o></obs>                    <obs><x>3</x><y>103</y><o>94.83413</o></obs>                    <obs><x>3</x><y>202</y><o>31.32913</o></obs>                    <obs><x>3</x><y>203</y><o>0.6568</o></obs>                    <obs><x>3</x><y>204</y><o>30.67233</o></obs>                    <obs><x>3</x><y>110</y><o>0.12503</o></obs>                    <obs><x>4</x><y>101</y><o>4.1997</o></obs>                    <obs><x>4</x><y>201</y><o>0.14416</o></obs>                    <obs><x>4</x><y>202</y><o>0.00215</o></obs>                    <obs><x>4</x><y>203</y><o>0.00215</o></obs>                    <obs><x>4</x><y>110</y><o>0.00491</o></obs>                    <obs><x>31</x><y>101</y><o>10.86208</o></obs>                    <obs><x>31</x><y>201</y><o>3.50152</o></obs>                 </observations>            </nReport>        </simpleReports>       </deliveredReports></SNBReports>
	Fig. 5: Example of valid XML file for a coordinates-based survey
	3.1.2.2.  Form identification, version numbers and data ranges

	Information relating to the report or form designations, the form versions and the row and column coordinates can be found in the corresponding Excel forms.
	/
	Fig. 6: Form information in XML file (XML format for coordinates-based surveys)
	The screenshot above shows the designation of the reportName and reportVersion in a given coordinates-based Excel survey document, and the screenshot below the designation of the <obs> <x> and <y> coordinates.
	/
	Fig. 7: Coordinates and data in XML file (XML format for coordinates-based surveys)
	4.  Delivery formats for subject-specific surveys
	The delivery formats that are available for subject-specific surveys depend on whether the survey in question uses web tables or Excel forms to record data. Surveys that do not use web tables for data collection can be submitted in either Excel or XML format. For those that do use web tables, data can be entered directly in the web table itself or be submitted in CSV or XML format.
	4.1.1.  Excel format for subject-specific surveys

	Subject-specific Excel survey forms are based on the XLSX file format, which has been the standard since Microsoft Office 2007. These Excel survey forms use the XML schema functionality in Excel, which was introduced together with the XLSX format. The XML schema supplied with Excel is identical to the schema for the XML reports.
	The Excel coordinates (row numbers and column names) in the tables are provided solely to simplify communications. The link between Excel coordinates and data points is dynamic, i.e. not static, and may therefore change over time. In conjunction with the Excel survey documents, reports in the XML delivery format may be imported into the corresponding Excel survey documents.
	Report data is extracted from the Excel report using an XML data export. The mapping of Excel cells onto XML schema elements is defined by an XML schema map tailored to each specific survey.
	The reporting institution must indicate the identification code (SNB code) and the reference date provided in the ‘Start’ worksheet.
	4.1.1.1.  Restrictions

	The key element of subject-specific Excel survey documents is the associated XML schema and the linkage of Excel cells with the XML elements in this schema. Manipulating Excel survey documents (e.g. renaming worksheets, inserting or deleting cells, changing the XML schema) can render these linkages with the XML schema unusable or may result in data values being allocated to the wrong positions. Altering the XML schema is therefore not permitted.
	Cells that contain formulas or references to external data sources may lead to problems during processing. The SNB therefore recommends avoiding such constructs when completing reports. The reporting process can be automated using the XML delivery format (cf. 4.1.1.7. Automation).
	If, during the processing of a report, any unauthorised modifications are identified or any errors due to formulas or references are encountered, the system will be unable to process the report and it will therefore be rejected.
	4.1.1.2.  Version, revision and technical numbers

	In the subject-specific Excel survey documents, the version and revision numbers can be found in the ‘Start’ worksheet as well as in the metadata of the XML schema. There is only one version number for the entire survey (whereas for coordinates-based surveys, there is one version for every form). The version defines the valid key domain. If the version number changes, so too does the key domain. If the version number changes, the new version and associated key domain must always be used. Submissions that do not correspond to the expected version cannot be processed.
	The revision number relates only to the Excel format and is changed, for instance, when the consistency rules are amended. If a change is required, or if a survey document with an older revision number can still be used, this will be indicated in the Release Notes of the respective release.
	The technical number is for internal purposes and can be ignored. It is incremented as soon as a survey document is imported into the system.
	/
	Fig. 8: Version, revision and technical numbers (Excel format for subject-specific surveys)
	4.1.1.3.  Sheet protection

	All Excel survey documents are provided with the sheets protected (without password).
	4.1.1.4.  Carrying out consistency checks

	Cf. Using consistency rules in subject-specific survey documents
	4.1.1.5.  Exporting XML data

	A valid XML report can be generated using a subject-specific Excel survey document.
	The recorded data are exported as an XML file using the XML schema supplied in the Excel survey document. An XML file exported in this way is considered by the SNB to be a valid XML report, which can be submitted via eSurvey.
	The contents of the Excel file can be saved in the XML Data format via the menu item ‘File’ → ‘Save As’.
	/
	Fig. 9: Saving Excel file as XML data (Excel format for subject-specific surveys)
	The following dialog box can be ignored and closed by clicking ‘Continue’.
	/
	Fig. 10: Saving Excel file as XML data: Dialog box (Excel format for subject-specific surveys)
	The export to an XML file is initiated by selecting the XML map ‘Report’.
	/
	Fig. 11: Saving Excel file as XML data: Mapping (Excel format for subject-specific surveys)
	The identification code (SNB code) and reference date must be entered in the ‘Start’ worksheet in order for a data export to an XML file to function properly. If either of these values are missing, an error message will be displayed during the export process.
	/
	Fig. 12: Saving Excel file as XML data: Error message (Excel format for subject-specific surveys)
	4.1.1.6.  Importing XML data

	The data saved in an XML report can be imported into the respective Excel survey document for control purposes. This enables the user to review the observations in the XML report in tabular form. If the import returns no errors, it means the structure of the XML file has also been validated.
	To ensure an error-free import, it is essential that the versions of both delivery formats are identical (cf. 4.1.1.2. Version, revision and technical numbers).
	An XML report is imported into the respective Excel survey document as follows: In the ‘Developer’ tab, click on ‘Import’ and select the appropriate XML file.
	/
	Fig. 13: Importing data from XML file to Excel file (Excel format for subject-specific surveys)
	The import process commences with the selection of an XML file. If no errors occur during the import, the data from the XML file will be displayed in Excel.
	If one or more errors are encountered, a dialog box detailing the errors will appear. Additional information on the reason for the error can be obtained by clicking on ‘Details...’.
	/
	Fig. 14: Importing data from XML file to Excel file: Error message (Excel format for subject-specific surveys)
	Possible reasons for import errors:
	 Error during schema verification: The XML file does not correspond to the specifications defined in the XML schema (e.g. languages differ or date format deviates from yyyy-mm-dd format).
	 XML parsing error: Syntax errors in XML file.
	4.1.1.7.  Automation

	The Excel delivery format is suitable for entering data manually or checking data, but is not suited to automating the reporting process.
	To achieve process automation, the SNB recommends using the XML delivery format, as this is the recognised format for transferring data between systems.
	The SNB reserves the right to reject Excel and XML reports that have been corrupted due to automation.
	Activate ‘Developer’ tab (Excel 2010): To activate this tab, go to File → Options → Customize Ribbon and under ‘Main Tabs’ click on ‘Developer’.
	/
	Fig. 15: Automation: Activating ‘Developer’ tab (Excel format for subject-specific surveys)
	4.1.1.8.  Displaying XML schema maps

	For a better understanding of how subject-specific content is rendered in Excel survey documents, the mapping of Excel cells to XML schema elements can be shown in Excel.
	In the ‘Developer’ tab, click on ‘Source’ to display the XML maps.
	Displaying the XML maps facilitates navigation. If a key is selected in the XML map, the corresponding position in the worksheet or cell will be framed in yellow. Conversely, if a position is selected in the worksheet, the key will be highlighted in blue in the XML map.
	/
	Fig. 16: XML maps (Excel format for subject-specific surveys)
	4.1.2.  XML format for subject-specific surveys

	The same XML format is used with both the subject-specific Excel survey documents and the web tables. In other words, the XML schema for web tables is the same as for those surveys that also use subject-specific survey documents. Excel cannot be used in combination with web tables and XML schema, however, as there is no Excel option for web tables.
	The SNB provides the relevant XML schemata for all subject-specific surveys. The structure of the XML schemata – which is the same for all surveys – falls into two categories:
	Metadata: These data identify the reporting institution’s report. Metadata are static for all XML schemata and identical for every survey. An exception is <ReportDomainName>, which is only available in conjunction with web tables.
	/
	Fig. 17: Meta data in XML file (XML format for subject-specific surveys)
	The reporting institution must indicate the identification code ‘SubjectID’ and the reference date ‘ReferDate’ in the yyyy-mm-dd format (e.g. 2014-12-31). All other details are control information for processing reports and may not be altered, as per the requirements set out in the XML schema. ‘Revision’, ‘TechNumber’ and ‘Language’ are optional for XML reports and should not be provided.
	Observation data: This is where observations are queried on the basis of the subject-specific content of a survey. Subject-specific content may change over time. Changes may relate to the subject-specific keys, and positions may be added and/or removed. In the event of any changes, the SNB will provide a new version of the XML schema.
	Reporting institutions must ensure that reports submitted in the XML delivery format correspond to the relevant XML schema. Reports that do not adhere to the schema cannot be processed by the system and will therefore be rejected.
	4.1.2.1.  Restrictions

	An XML file may only contain a report for one survey. Consolidating different reports and/or surveys into one XML file is not possible for subject-specific surveys.
	4.1.2.2.  XML format for web tables

	The XML format for web tables is also based on the subject-specific model. A distinctive feature here is that there may be a set of preliminary questions in the web tables (such as in the CAS survey), which helps to customise the survey content. These questions are also mapped in the XML schema and form part of the report. Each answer to a question corresponds to a component and represents a given key domain. Mandatory questions must also be answered in XML. The remaining questions relate to the customisation of the survey content and the value ‘EMPTY’ must be given for all these questions.
	4.1.3.  Web tables for subject-specific surveys

	Web tables are based on the subject-specific data model and are integrated into eSurvey. If a survey is provided in the form of web tables, the Excel option is no longer available. The CSV format can be used in addition to web tables (cf. 4.1.4. CSV format for subject-specific surveys). The XML schema – which can also be used with web tables – corresponds to the one used for the subject-specific data model (cf. 4.1.2. XML format for subject-specific surveys).
	By answering the preliminary questions, reporting institutions can tailor the web tables to include the survey content specifically relevant to them. The purpose of this is to make the reportable data more readily comprehensible. Furthermore, the notes on the individual surveys can be displayed directly in the web tables to aid data entry. Both are intended to contribute to a better understanding of the data requirements and to assist reporting institutions in preparing reports.
	Data can be entered directly in the web tables, either manually or by inserting data from external sources. However, protected cells must be omitted from the copying process.
	The reporting process can be automated using the XML format. Likewise, the entire or previously customised survey content can be downloaded as a CSV file.
	Additionally, in conjunction with the user administration in eSurvey, the system allows reports to be stored temporarily and processed by different users. At the same time, the web tables also permit access to previously submitted reports.
	/
	Fig. 18: Sample view of web table
	4.1.4.  CSV format for subject-specific surveys

	The CSV delivery format is an additional format that can be used with web tables. The CSV file can be opened in Excel and linked with internal Excel or other data sources. This allows reports to be prepared either locally or offline. Reports created in this way can then be uploaded into the web tables where they can be displayed, edited where necessary, checked for consistency and finally submitted.
	4.1.4.1.  Technical specifications of the CSV format

	The following format must be adhered to when processing the CSV:
	 Character set encoding: 
	 Windows-1252 or ISO-8859-1 (Western Europe) for Windows or Linux
	 UTF8 for MacOS or Linux 
	 The column separator is a semicolon (;)
	 If the column separator (;) is contained in a value (‘Value’ column), the value must be placed in inverted commas (").
	 For the import into eTable, at least the ‘Position’ column (position key) and the ‘Value’ column (observation/question value) must be present.
	4.1.4.2.  Editing CSV file

	The figures in a CSV report must be in Swiss format ([decimal separator: point], [optional: thousands separator: inverted comma, e.g.: 10'000'000.00]). If you normally use another format, when you open the CSV format in Excel under ‘Advanced options’, you must ensure that the decimal separator is set as a point and the thousands separator as an inverted comma.
	/
	Fig. 19: Setting Swiss number format for editing CSV template
	To make editing easier, you can adapt the column widths in the CSV file opened in Excel so that you can see the whole sheet. You can get a better overview by setting up a filter.
	If a CSV file is created from Excel via ‘Save As...’, double quotation marks are placed only where needed. This is also permitted.
	/
	Fig. 20: Saving Excel as CSV
	4.1.4.3.  Changing regional settings in Windows

	In order to be able to process the CSV formats directly with Excel, the required formats must be set to German (Switzerland) in the regional settings. Individual settings, e.g. column separators, can be changed there as follows:
	1. Click on the ‘Start’ menu, then open ‘Settings’. Select ‘Time & Language’, ‘Region’, then open ‘Additional date, time & regional settings’:
	/
	Fig. 21: Opening regional settings
	2. Open region
	/
	Fig. 22: Opening region
	3. Additional settings
	/
	Fig. 23: Additional settings
	Change the relevant setting, e.g. the list separator and the decimal symbol:
	/
	Fig. 24: Setting list separator and decimal symbol
	4.1.4.4.  Opening CSV file without changing regional settings

	The CSV file can be imported into Excel (Windows and MacOS) or opened in OpenOffice (Linux) if the regional settings cannot be changed.
	1. In Excel, the CSV file is imported via ‘Data’ -> ‘Get External Data’ -> ‘From Text’.
	/
	Fig. 25: Importing CSV into Excel
	2. Under ‘Original data type’, choose the file type ‘Delimited’ and then select the following character set under ‘File origin’): 
	For Windows and MacOS: Windows (ANSI)For Linux: Western Europe (ISO-8859-1)
	/
	Fig. 26: Setting original data type
	3. Under ‘Delimiters’, select ‘Semicolon’ and under ‘Text qualifier’ (string delimiter), select double inverted comma (").
	/
	Fig. 27: Defining the delimiter and text qualifier
	4. The column formats can be left unchanged.
	5. Click ‘Finish’ to conclude the import (with the cell position =$A$1 in the subsequent dialogue).
	6. To save the report for uploading, specify the file name in the save dialogue and use the following format:
	For Windows: CSV (Comma delimited)(*.csv) For MacOS: CSV-UTF-8For Linux: CSV-Text
	4.1.4.5.  Sections of CSV file

	The CSV file contains the following sections:
	#Meta-data: This section identifies the report and contains the link to the notes.
	#Questions (mandatory and non-mandatory): The questions in the CAS survey relate to the web tables ‘Questions on your company’ and ‘Select components’ and are divided into two sections. The mandatory questions (‘Questions on your company’) are displayed at the top of the CSV file before the other observations. The other questions (‘Select components’) come after the observations section (#Questions). We recommend completing these questions in the web table, then exporting the CSV file.
	#Observations: This section contains the list of keys, including their description for those web tables for which a report is required. If no applicable components were previously selected in the web tables under ‘Select components’, this list will contain the entire key domain of the survey. We therefore recommend you preselect the relevant survey content in the web tables by explicitly selecting the applicable components. We do not recommend deleting keys in the CSV file later on (cf. Help with eSurvey).
	#Content domain definition: This section contains the information about the content configuration of the survey, which represents the link between the questions, the sections and the associated positions. This section is not to be edited.
	4.1.4.6.  Columns in CSV file

	The CSV file contains the following columns:
	The ‘Position’ column contains the technical descriptors or subject-specific keys of the survey for each section. See also the previous section for information in this regard.
	The values for the positions to be reported must be entered in the ‘Value’ column.
	/
	/
	/
	Fig. 28: Structure of CSV delivery format
	The ‘Type’ column defines the required data type for the value that is to be reported in the ‘Value’ column. The following formats apply:
	 DATE: DD.MM.YYYY
	 DOUBLE: Example: 100000.00 (decimal point required as decimal separator)
	 ENUM: Defined range of values (possible values are listed in the ‘Type’ column). Example: ENUM (mandatory) [IFR,USG,SWG,OTH] (mandatory)
	 STRING (mandatory): Text (mandatory)
	 BOOLEAN: True, false
	The ‘Value’ column may also contain references. This can be problematic, however, if such references cannot be resolved or updated.
	The best way to deal with references is to keep them in the ‘EXT Link’ column and then to transfer them to the ‘Value’ column using ‘Copy’ and ‘Paste Values’.
	The ‘Range’ column shows which web table corresponds to a given position. This column can be used for filtering.
	The information in the ‘Predicate’ column is used to identify the content configuration of the survey. This column does not require any editing by the reporting institution.
	The ‘Component’ column and the ‘Dimension’ columns contain the component designation and the dimensions for a position’s key. These columns can be used for filtering.
	4.1.4.7.  Special features Current account survey (CAS): Questions on your company

	In the CAS survey, there is a special feature in the web table ‘Questions on your company’ with regard to recording group-affiliated companies. For every company listed, the following values are recorded in one line: ‘Enterprise identification number (UID)’, ‘Company name’, ‘Town’ and ‘Included in the report’. These lines are displayed only twice in the CSV template. When entering several companies, these lines must be copied in the CSV file, and in the keys the dataset’s counter must be increased by one (e.g. from #GES[1] to #GES[2]).
	/
	Fig. 29: Group-affiliated companies in web table
	/
	/
	/
	Fig. 30: Group-affiliated companies in CSV template
	If the preliminary question ‘Are several relevant companies in the same group domiciled in Switzerland or Liechtenstein?’ is answered with ‘YES’ (in the web table with ‘Yes’), at least one company must be recorded in the first line (‘mandatory’). This does not apply, however, if the question is answered with ‘NO’.

